TR7 Series Thermo Recorder TR71A/TR72A/ TR72A-S For the Users of TR71A

The TR71A has a “Vaccine Mode” setting that is suitable for such as vaccine storage and monitoring, which require strict temperature management. When

1
Use r S M a n u a l. this mode is enabled, the following features are available:

. . . . . T he TR71Af i h i f
- W T T 0ae (e daman) ﬁ o use the or vaccine management, please read the reverse side o

. this document carefully, and make settings in “Vaccine Mode” using the

T& D . « Auto Reset Max/Min Values "TRT for Windows" f)t/’ g g
Corporatlon Monitor and record maximum and minimum temperatures for the day. or Windows™ software.

* The button operations (such as recording interval, auto-upload interval, and wireless

tandd.com » CSVFile Created upon Data Download LAN settings) can also be configured with this software.

© Copyright T&D Corporation. All rights reserved. 2021.04 165049300XX (Xth Edition) Manage reports on the daily maximum and minimum temperatures and total time out of range.

In this document, TR71A, TR72A and TR72A-S are collectively referred to as

the “TR7A Series” or simply as the “device” or “logger” . Recording |nterval Setting

How to Use Install the batteries and sensor(s) in the logger, and make sure the LCD is displaying measurements.
The factory default setting for the recording interval is 10 minutes. Follow the procedure below to change this setting.

There are mainly two ways to set up the device and manage the recorded data as

follows. . Skip this setting if you don't need to change the recording interval. 5. W!‘]el? the desired recordinginterva! appears, stop pressing the button.
_ ) « Upon the start of recording, all previously recorded data in the logger will be Within a few seconds, the display will return to measurement mode to
Via Cloud: Automatic Data Upload @ deleted. indicate the recording interval is set.
« Note: When &3 is ON (recording in progress), the logger cannot be turned Ref: R ding | ls & Esti d Maxi R dine Ti
By using wireless LAN, the logger automatically uploads recorded data to the cloud off, nor can the recording interval be changed. . et ecc?r ing Intervals & Estimated Maximum ec?r Ing Times
Iitgriﬁqee;:tt ehn:r:)eleasnt;'tea\gfev:lng of uploaded data and the changing of settings on your ' . . Rlectordlr;g 0 e 30 sec 3 i (gl.Ofmlll’lt) 15 i SO
; P : 1. Press-and-hold the <REC/STOP> button until G&3 turns OFF (recording stops). ¢ =l Sl
: Estimated | About8 | About 10 |About 100 About200| Aboutl | About 3.5
2. Press the <INTERVAL> button. @ <'m . Time hours days days days year years
Via PC: Setup and Download 3. WhileRec.is displayed, press-and-hold the aw : —
<INTERVAL> button until the interval time + 6. Press-and-hold the <REC/STOP> button until (E@B)crme 22
Make settings and download data by using the USB connection and PC software. flashes. . G turns ON (recording restarts). - 0T
« If you are using the TR71A for vaccine storage and management, please follow this 4, Press the <INTERVAL> button again to select the interval time RecInterval ¢ @ '.l' "._'. -l' ‘
method. Recording Intervals (Rec.) 1,2, 5, 10, 15, 20,30 SEC /1,2, 5, 10, 15, 20, 30, 60 MIN : 2 NP

Marks on LCD Screen

Automatic Data Upload to the Cloud

e  comEISNRHWE Sath
° Upload Rec. HOUR MIN SEC . . . . .
Web WPS] A0c The auto-upload function enables TR7 series loggers to automatically upload recorded data to the free cloud storage service "T&D WebStorage Service".
(@D Max -,-’-_’ . The uploaded data is available for viewing from a web browser.
(2)CD Mmin ," ", L The factory default setting is OFF (no auto-upload). Please follow the steps below to change the setting.
ﬁ Please read the "T&D WebStorage Service" License Agreement carefully before making settings. Making Auto-upload Settings indicates your acceptance of this
Wireless LAN Agreement.
o> | ON:Connected to the wireless network. (Signal strength: 1 to 3 bars)
° BLINKING : Unable to connect to the wireless network.
OFF : Wireless LAN Settings are not made or Auto-Upload is “OFF” .
. View with a Web Browser
ON : Connected to the server. Auto-upload of Recorded Data G"aPhID'ZPIIDay e e g
Web | BLINKING : Unable to connect to the server. > Dol =
OFF : Wireless LAN Settings are not made or Auto-Upload is “OFF” . T&D
((31) Wireless/Wired LAN WEbStDragE [
[I]@ Displayed Measurement Channel === ——— Service - ?et; - en o= : E
ON : Wireless LAN Setup using WPS Possible Apply Settings loud =
com ON : Connected via Bluetooth or USB.
BLINKING : Bluetooth or USB communication in Progress
. « This procedure requires Internet access via wireless LAN.
@3 |ON:Recordingin Progress + Old data that exceeds the storage period will be deleted from "T&D WebStorage Service". Please check the details at T&D WebStorage Service License Agreement > Service Details.
ENDLESS : Upon reaching the logging capacity of 30,000 readings, the . ) . . ) )
oldest data is overwritten and recording continues. If}/ou wish to use a static IP addrssmstead of DHCP, make network settings Vl@Wlng Recorded Data
ENDLESS ) . . - . with the software.
onerime | ONETIME : Upon reaching the logging capacity of 30,000 readings, record-

ing automatically stops.
Cannot be set or changed using buttons on the logger.

In order to view the recorded data on a web browser, it is necessary to register
devices to T&D WebStorage Service in advance.

mamm | Amount of Recorded Data in Device

@ Making Auto-Upload Settings

1. Access "T&D WebStorage Service" from the web browser.
Battery Warning Mark

BLINKING : Indicates low battery . Pressthe <INTERVAL> button twice to display h [ [ WWW.W r -servi m
ON : Wireless and Bluetooth communication will stop. (Recording will the auto-upload interval. 0 ttps.// -websto age-se ce.co /
continue.) ) o T . N .
| « Replacing the batteries while this is displayed will allow recording to continue uninterrupted. Please 2. While Upload. is displayed, press-and-hold the ,"‘_,, 2‘ Click [Create Account] to go to the registration page, and follow the direc-
change the batteries as soon as possible when you see this mark. <INTERVAL> button until the interval time tions to complete the registration. If you already have your User ID, go to the
« If + (plus) and - (minus) are mistaken, or if the battery terminals + and - are shorted, the recorded
data that is stored in the device will be lost. flashes. next step.
+ The logger will stop measuring and recording data after about 3 minutes of battery removal. When . . load |
replacing batteries, install new batteries as quickly as possible. 3. Press <INTERVAL> again to select the interval utoDploadinterva 3. Login by entering the registered User ID and Password.
Upload | Auto Unload Interval time. Each press changes the interval as follows:
P Auto-upload Intervals (Upload.): OFF / 1,2, 5, 10, 15,20,30 MIN / 1,2, 3,4, 6,12, 24 HOUR 4, Click [Devices] in the left menu to open the Device Settings window.
Rec. |Recording Interval o . . .
: : — 4, Theinterval time will stop flashing and the display will return to the normal 5. clicking the [+Device] button will take you to the Add a Device page.
BLINKING : Indicates either upper/lower limit error or sensor error measurement mode, confirming that it is set. ) ) . N
6. Enterthe serial number and registration code* for the target logger, then

MaxMin | Maximum and Minimum Readings Ref: Auto-Upload Intervals & Corresponding Estimated Battery Life

In general, the shorter the upload interval, the shorter the battery life.

click [Add].

Messages on LCD Screen Upload Interval 1 min 10 min 1 hr 12hrs or more * The registration code can be found on the supplied Registration Code Label.

J—TY . About 2 About 15 . . .

@ — _ T | Indicates asensor error (No sensor connected, improper Battery Life | About10days| '~ | Aboutlyear months 7. Afterdataissentto either by auto-upload or by pressing the <REC/STOP>
connection, damaged, etc.) button on the logger, the added device and its measurements will appear in
@ T T % « All estimates are based on operations carried out with a new battery and are in no way a the [Data View] window
guarantee of actual battery life. )
_ Recording Full (Recording Stopped) + When Auto-upload is u§ed frequently on TR71A, the measurement of the internal sensor . .
rEL. This appears when the logging capacity (30,000 readings) may rise by around 0.3 C. TrOUbIeShOOtmg TIpS
Furt is reached in “ONETIME” mode.

If measurements are not displayed:

Check the screen of the logger and make sure &3 is ON; If not, press-and-hold
<REC/STOP=> to start recording. See “Recording Interval Setting above.

Dead Battery

@ Making Wireless LAN Settings
If you take no action after the battery warning mark

a2 appears on the display, the logger will show this message @ To use the WPS feature, make sure to select WPS2-PSK(AES) or disable wireless

If the display of measurements is not refreshed:

Try making the recording interval shorter. If the recording interval is set to longer
than the upload interval, the same measurement is displayed until the next

and stop recording data. security in your access point settings. Wireless LAN settings using WPS may not

Lo
b HE [ The logger will then turn off the LCD display and reset the internal clock. If you . . . .
change the batteries at this point, it is still possible to download all saved be possible depending on the supported features or settings of your wireless

recorded data. The recording cannot be continued. LAN access point. In this case, please make wireless network settings on PC. recording occurs and the new data is uploaded.
e
Upper part : Bootloader Version The following information is required: If you lose your registration code label:
] L',l,l_"lL'l Lower part : Firmware Version + Network Name (SSID) Open the software "TR7 for Windows" and connect your logger via USB to the

« Security (WEP 64bit/128bit, WPA-PSK (TKIP), WPA2-PSK (AES))
« Password (Network Key)

computer. The connected logger and its information will appear in the left boxes of
the main window. The registration code can be found here.

H QM | This appears immediately after the power is turned on.

If you wish to save recorded data to PC:

Button Operations 1. Pressthe <P\_NR> and <DISPLAY> buttons @‘)"E:ME_!"""'Q Use "T&D Graph" that is available for download from the T&D Website.
together until appears on the LCD screen. @) .,l,l., ,l C See on the reverse side.
*1 T = wmo
Power ON/OFF Press-and-hold**the <PWR> button. 2. Set your wireless LAN access point to "WPS" 2 ,.’, ,.’ ,, T
Start/Stop Recording Press-and-hold*!the <REC/STOP> button. mode. —
Press the <INTERVAL> button. For details about Wireless LAN Access Point settings, refer to the user manual for Changl ng Device Setti ngS
Check Recording Interval / With each pressing of the button, the display will that access point. _ . ' ' . .
Upload Interval switch between the recording interval (Rec.) and — Itis possible to change device settings by using "T&D WebStorage Service".
the upload interval (Upload). 3. When the setup is successfully completed, the % mark on the LCD display In the Device Settings window click the [Settings] button to open the settings box.
will turn ON. Make the necessary changes and click [Send Settings].

Press the <INTERVAL> button. While Rec. is

Recording Interval Setting displayed, press-and-hold the <INTERVAL>
button until the interval time flashes. Press . .
<INTERVAL> again to select the interval time. @ CheCklng Connection Status

tween the logger and "T&D WebStorage Service". By pressing the <REC/STOP>

@ The setting changes will not be actually applied until communication occurs be-
button on the logger, however, settings can be applied immediately.

Press the <INTERVAL> button twice. While Upload Place the logger in the desired measurement location where Internet access is -
. is displayed, press-and-hold the <INTERVAL> available. g oereae servee B

Upload Interval Setting button until the interval time flashes. Press _ _ —

<INTERVAL> again to select the interval time. Internet Connection Status Indicators
Transmit Data and Settings to B onerme £272, —T—
"T&D WebStorage Service" Press the <REC/STOP> button. A <I- 1T .

- : w :, L.,. ’ TR-7 series
Cancel Communication Press the <PWR> button. Wireless LAN Yl ks s P e e
Access Point [Z] -’ -, Tadenn Device ome Inteval  Inferval  Satumgs  Name

Press the <DISPLAY> button to switch the display: — o ome o Tupd EEEE | A

Switch Display Items and Pattern | Ch1/Ch2 current values (fixed) = Ch1 Max/Min b omeen tmnism o e i

Press the <REC/STOP> button to immediately send the recorded data to
"T&D WebStorage Service" without waiting for the next transmission. If the
transmission is successful, Web will remain ON after COM turns OFF.

(Fixed or Alternating Display) values (fixed) = Ch2 Max/Min values (fixed) =
alternating display

While Max/Min (and ALM) are displayed (in fixed

Fl
)
§
3,
-

Setting Items which can be set or changed:

Clear Max/Min (and ALM) . “l = is OFF or blinking: Unable to connect to the wireless network.
display), press-and-hold*" the <DISPLAY> button. Try changing the measurement location or adjusting the Device | Device Name, Group Name, Recording Interval, Recording Mode, Auto-
s LA i G Press-and-hold** <PWR> and <DISPLAY> distance between the logger and the access point, and Info Upload Interval, Time Difference, Temperature Unit, Channel Name
Ireless ettings using together. make the wireless LAN settings in STEP 2 again. Warning | Lower Limit, Upper Limit, Sensor Warning, Judgement Time, Battery Warning]
*1."Press-and-hold" means to hold the button down for about two seconds. Wehbis blinking: Internet connection failed. Settings

*2.Recording Interval setting cannot be changed while a recording session is in progress. Please check the access point’ s internet connection.




PC over USB: Setup and Download

Using a USB connection between the logger and PC, make device settings and download recorded data via "TR7 for Windows".
c « The software can be downloaded from the T&D website, but for those who prefer, a CD and USB cable set (SO-15C1) is available for purchase.

USB Connection
(Setup and Data Download)

Software Download (free) >> tandd.com/software/

Primary features of
"TR7 for Windows" include :

» Recording Start/Stop

« Auto-upload Setting

« Network Settings (static IP address, etc.)

« Name Settings (device/group/channel)

» Downloading and Saving Recorded Data
» Warning Settings

» Clock Settings

« Clear Max/Min at Specific Time of the Day

1. Download "TRY for Windows" from the T&D Website and install it to your PC.
tandd.com/software/tr7forwin.html

2. Connect the logger via USB to your computer.

* "TRT for Windows" will open automatically. (If not, please open it manually from the
Windows Start Menu or Start Screen.)

3. Click the [Start Recording] tab and make necessary settings for recording.

[E§ TR7 for Windows - x
File View Communication Settings Help
.04 =] (o)
HETEEE
Crgi Jevas & Download Recorded Dahl &) Start Recording | l Warning Settings | ‘[ Auto-upload |
—
B
‘ | Recording Start Date and Time ——————————————
=223 Start Recording
TR72A " Programmed Start 2021/04/09 -
—— Stop Recording
 Immediste Starf = j
Get Settings
Current Date /Time— - Est. Finish Date/Time
Apr-9-2021 Endless [~ Vaccine Mode
164245
Item | Reading Hel
Model Name TR72A P
Group Mame GROUP1 o 5
ki TR72A Recording Interval Recording Mode
ch.1 Name ch.a
ch.2 Name ch.2 lm"‘—;l @ =i
Rec.Interval 15 min. :
Rec.Start Date/... Mar-11-2021 10:48:39 9 =
Rec.Start Method  Immedite
gﬁim}ﬁm a E’gjlff  Group Name / Device Name / Channel Name
Ch.2 Adjusted NOMNE I Set
Serial No. 52148401
Regstration Code  56351L Group Name
Data Folder Cr¥lUserss Mo ianiD. ..
Battery Level Sufficient Power Device Name
Warning Settings  OFF
Auto-Upload Int... ON:30 min. Cha
Auto-Upload Des... 10.2.254.130:80
MAC Address 00:0d:8b:13:56:b2
Firmware Version  1.07 e
Ready [11]

Setting Items in [Start Recording] tab:

Recording Start Method (Programmed Start or Immediate Start), Recording Interval,
Recording Mode, Group Name, Device Name, Channel Name

~ |nVaccine Mode:
Recording intervals will be short (30 sec, 1 min or 2 min) for strict monitoring.
* The warning judgment is made immediately at each recording interval.

4, Click the [Warning Settings] tab and make the necessary settings.

5§ TR7 for Windows - x
Eile View Communication Settings Help
Lol g | (a2
HE T EEEE
Connected Devices & Download Recorded Data | & Start Recarding Warming Settings |‘ " Auto-upload |
(—
i | e Sends
CEES ) nd Settings
TR72A I~ ilpper Limi# 5
™ Lower Limit Get Settings
Sensor Warning ©ON @ OFF
Warning Judgement Time [ 0oec. W Vaccine Mode
Ch..
Item | Reading
Model Name TR72A I UpperLimit .
Group MName GROUP1
Device Name TR72A ™ Lower Limit
Ch.1 Name ch.1
Ch.2 Name th2 Sensor Warning CON  OFF
Rec.Interval 15 min.
Rec.Start Date/... Mar-11-2021 10:48:39 Osec.
Rec.Start Method  Immedite Wamg o ment Jne

Rec.Mode Endless

ch.1 Adjusted NONE -
ch.2 Adjusted NONE Eet=iive g o
Serial No. 52148481
Registration Code 563511
Data Folder Co¥lUserss i i ¥D... C ZEL733
Battery Level Sufficient Power
Warning Settings ~ OFF UTES T 0:00:00 |
Auto-Upload Int... ON:30 min. [ U (=3l
Auto-Upload Des... 10.2.254.130:80 =
MAC Address 00:0d:8b:13:56:b2 [ ZU7EE LR = Help
Firmware Version  1.07
Ready [

Setting Items in [Warning Settings] tab:

Lower Limit, Upper Limit, Sensor Warning, Warning Judgement Time, Battery Warning,
Clear MAX/MIN Values at Specific Time (in Vaccine Mode only)

« By changing the temperature unit to Fahrenheit in [Settings] - [LCD Display Settings]
menu, the upper and lower limits can be set in Fahrenheit here.

- In Vaccine Mode
o@ « Warning Judgment Time is set to 0 sec.(Warnings will be generated immedi-
ately when thresholds are reached.)
« There is an option to automatically clear Max/Min values at specific time
every day.
« For details about the Vaccine Mode, see [TR7 for Windows Help].

5. Clickthe [Auto-upload Settings] tab and make wireless LAN network settings.

X

B8 TR for Windows -

File View Communication Settings Help

= E

&} Download Recorded Data | @] Start Recording | @ Warning SEtling;I " Auto-upload |

BE T

Connected Devices

- Metwork Setting:
Send Settings
W| Network 2 | Network 3 ‘
Get Setti
DHCP & ON " OFF i
IP Address e oG b
Subnet Wask U Upload Interval
DENED [} [} 1h ~
o e Default Gatewsy I | |
Model Name TR72A DS Server (Primary TN T G
gmup ':j’"“e Frggzu:l Data Destination...
avice Name
Ch1 Name Cha DS Server (Secandary) O O D
Ch.2 Name Ch.2 -
Rec.Intenval 15 min. [ Wireless LAN Setting
Rec.Start Date/... Mar-11-2021 10:48:39
Rec.Start Method  Immediate Netwark Name(SSID) =
Rec.Mode Endless
Ch.1 Adjusted NONE Security WPA/WPAZ PSK hd
Ch.2 Adjusted NONE
Serial No. 52148411 Password
Registration Code 5635811
Data Folder Ci¥Usersy s ias¥D...

Battery Level Sufficient Power
Warning Settings OFF LR
Auto-Upload Int... ON:30 min.

Auto-Upload Des... 10.2.254.130:80 el

MAC Address 00:0d:8b:13:56:h2
Firmware Version  1.07 Port Number Help

Ready [TT]

Setting Items in [Auto-upload Settings] tab:
DHCP, Wireless LAN Settings, Proxy Server, Upload Interval, Data Destination

6. After having completed all the settings, click [Start Recording] (in the Start
Recording tab) or [Send Settings] to send the setting contents to the logger.

* Upon the start of a new recording session all stored data will be deleted from the de-
vice.

By using "T&D Graph'", it is possible to view data downloaded from the logger in
graph form.

1. Download "T&D Graph" from the T&D Website and install it to your PC.
tandd.com/software/td-graph.html

2. Connectthe logger via USB to your computer.

3. Open "TRT for Windows", click the [Download Data] tab and proceed with
the download.

* Before starting the download, settings for “Graph Display” and “File Name" can be
viewed and changed under [Detailed Settings].

B TR7 for Windows - X

File View Communication Settings Help

=) (2| | I

& Download Recorded Data | & Stort Recording | 8 Waming Settings | “|” Auto-upload

ME T

Connected Devices

Downloading
Device Name -
Detailed Settings...
Device Type:
o 50 100%

Ttem | Reading o/ope
Model Name TR72A File Name :

Group Name Office2F

Device Name TR72A

Ch.1 Name Ch.1

Ch.2 Name Ch.2

Rec.Interval 5 min.

Rec.Start Datey...

Rec.Start Method  Manual
Rec.Mode Endless
Ch.1 Adjusted NONE
Ch.2 Adjusted NONE
Serial No. 32120108
Registration Code  0011m7ms

Data Folder C¥UsersémamcankD... 0/ 0Units
Battery Level Change batteries im... Help
Warning Settings ON

Auto-Upload Int... ON: 1 min.
Auto-Upload Des... 10.2.254.130:80
MAC Address 00:0d:8b:11:02:52
Firmware Version  1.12

Overall Progress

Ready 1]

BQ completion of the download. By calculating the time in warning, it can be
used for vaccine quality control.

When downloading data from the TR71A that is set in Vaccine Mode, the total
amount of time out of range (temperature excursion) will be displayed upon

4. Upon completion of the download, "T&D Graph" will open and display the
graph.

[ *36100D_20181217_115621trz - T&D Graph TTaTx
Elle Edit View Settings Tools Help
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* For details about software operations, please see the “Help” menu in each software.

Storage Location of Recorded Data

Data downloaded via "TR7 for Windows" will be saved in the default folder
"Documents(or My Documents)\TandD Corp\TR7 for Windows".

Recorded data is saved in two formats: TRZ format file for display in the "T&D Graph"
and CSV format file.

By making warning settings for the TR71A in Vaccine Mode (to monitor
T upper and lower limits and to clear the MAX and MIN values at specific
é@ time of the day), the total time out-of-range and daily maximum and
minimum temperatures are recorded in the CSV file, which can be used

for daily reports.

The storage location can be viewed or changed from the [File] menu - [File Names and
Folders] option.

File Names and Folders

—Default File Name Settings

" Device Name + Date/Time

Cancel

i

" Device Name + Serial No. + Date/ Time
" Date/Time + Device Name
" Date/Time + Serial No.

" Date/Time + Device Name + Serial Mo.

File Mame Example: (Serial No.=00001234)

ABCD1234_20210400_180818.trz Help

—Storage Folder Settings

Device ... | Folder | Serial No. |
EastA_wf C¥lUserséias@¥Documents¥Tan... 32120...

Select Folder... |

Tips

What is the WPS?

WPS (Wi-Fi Protected Setup) is a feature that makes it easy to connect wire-
less LAN devices (such as smartphone, PC, TRTA, etc.) to a wireless router.

Normally, when connecting a wireless LAN device to the network, you need to
set the name (SSID) and password (encryption key) of the router manually.
However, if your device and router support WPS, you can complete the
wireless network setting with just a push of a button.

Button name of the WPS may differ depending on the router.

Optional Sensors

(D Temperature Sensor suitable for Vaccine Management

When using the TR71A for vaccine management, we recommend the optional
sensor TR-1106.

We offer a wide range of Temperature and Temperature-Humidity sensors,
sensor extension cables, AC adaptors, etc. For details see information on

T&D’s Product Page or Optional Products Catalog. the Optional Products
information on the Product Page.

tandd.com/catalog/files/op_others-eng.pdf

External Power Supply

Itis possible to use USB bus power and AC adaptor (AD-05A2 or AD-05C2: sold
separately) as a power source. When using an external power supply, install-
ing batteries will make it possible to continue recording in the event of a
power outage.

@ Important Notice for Using an External Power Supply

When using external power, the logger itself generates heat and the internal sensor
of the TR71A will report a higher temperature than actual; we recommend using
an external temperature sensor. Also, when an external sensor is used near the
logger, it may be affected by the heat from the logger.

T&D WebStorage Service

"T&D WebStorage Service" is a free web-based cloud storage service provided
by T&D Corporation. By uploading recorded data to "T&D WebStorage Service",
itis possible to access your important data from anyplace in the world at any
time you wish.

https://www.webstorage-service.com/

Via the browser you can check the current readings and battery level, view
the graph, make warning settings, etc.

Device Info =
TR-71Wb secis Frmvare : Var. 1.00

. Group Name :
Device Name : Office (2F) TANDD_DEMO

Rec Interval : 2 min. (applied) ~ Rec Mode : Endless (applied) ~

Auto-upload Interval : 1: (applied) ~ Batt Level :
It s recommended to set au e ——

Time Difference : +9 ~ : 00 ~ <Daylight Saving Time : OFF

ch. Name : On Desk ’

ch.2 Name : Window Sill ’

Warning Settings (rempersture: 0 to 1550 )
Lower Limit Upper Limit sensor W
Ch.1 B0 Bc B8 Hc ON ~

ch.2 o c 1o Jc OFF ~

I Start re
erased wh:

Z00m] Use mouse drag o zoom i
[Channd ON/OFF] Clck graph legend charinel.

Time Difference Setting

Please set the time difference in your time zone on "TR7 for Windows" as well
as "T&D WebStorage Service".

TR7 for Windows
[Settings] - [Clock Settings]

Time Settings
| Send Settings I
Time Difference UTC+09:00 |
Get Settings
PC Setting : UTC+9:00 Close

Daylight Savings Time i ON + OFF

T&D WebStorage Service
[Devices] - [Settings] - [Device Info] - [Time Difference]

Device Info (settings received: Apr-02-2021 02:36:59 UTC)

TR71A serial No. / Firmware : Ver. 1.06

Device Name : Group Name :
Rec Interval : Rec Mode : w
Auto-upload Interval : It Is recommended to set auto-upload interval longer than the recording interval.
Time Difference : B Daylight Saving Time : Temp Unit :

The default setting is as follows:
GMT +1:00 (for serial number "No.4XXXXXXX")
GMT -8:00 (for serial number "No.3XXXXXXX")

Other Software

T&D Graph

"T&D Graph" is a software program which enables the viewing of recorded
data in graph form, whether the data is stored on a local computer or at
"T&D WebStorage Service". Even if the data you wish to view is divided into
multiple files, it is possible to merge them into one graph by specifying the
device name and/or time period. The graph data can be saved as a graph file
(.trg) or a text file (csv).

tandd.com/software/td-graph.html

T vasamoro A 2010111575~ 780 Gaph N - . W Y
e

Troubleshooting

Please contact the distributor from which you
purchased the product.

tandd.com/purchasing/




